APPENDICES A

Power distribution system modeling with DIgGSILENT PowerFactory

A.1 DIgSILENT PowerFactory program

DIgSILENT PowerFactory or PowerFactory program is a program used to create
the model. To analyses power supply system, all models can be created in the form of
pictures or writing. The program writing in the form of a Text File also has the ability to
analysis power supply system. A wide variety of power flow analysis, problem analysis
and short circuit. The Analysis of protection systems, power loss analysis system analysis
and reliability. A system for using DIGSILENT PowerFactory program in this thesis will
be used the program to Version 15.1 in DIgSILENT PowerFactory [14] modelling and

analysis of the issue.

A.1.1 The structure of the program PowerFactory

The structure of the program, there are several PowerFactory sections on this
topic will be discussed. The specific structure of the highlights includes a data
management structure for the various electrical systems. It created and stored in the

program window's components PowerFactory Main Window.
1)  The management structure of data in the program PowerFactory

The information management program will be located in the Data
window PowerFactory. Manager, which shows the folder structure to store data in a
Database as shown in Figure A.1.

1.1 Main Library Folder contains the Types and Models of various

standards programs PowerFactory.

1.2 System Folder contains the o bject used within the PowerFactory

which, if you want to update in the User must Log on Edit. Only Administrator's Account
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and what should be done under the guidance from DIgSILENT customer support because
it will affect the operation of the program.

1.3 User Account Folders contains a folder of the Project and Setting.
Normal User-defined according to various examples is the Aksacksy User.

E Data Manager - :

— O *
1.1 B R G wess D AR & HE
F . Database - L Name Object modified Object modified by

(3 Configuratiadi
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Ln1 4 object(s) of 4 1 ohject(s) selected Drag & Drop

Figure A.1 Shows the Data Window Manager the data storage structure

2)  The various components of the Main Window.

Components of the Main window, the Window contain the 10 key
components as shown in Figure A.2.

2.1 Title Bar is the bar shows the name and Version of the program.

2.2 Menu Bar is the main command bar of the program.

2.3 A Main Tool Bar button is used instead of the main Menu Bar in
command, which can be activated immediately.

2.4 Drawing Tool Bar buttons that are used to create the device, an
electrical system in a different model.

2.5 Data Manager Window is a window that displays a Data structure
to store all of the data.
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2.6 Context Menu is the window that is displayed when you right-
click the folder in the Object Data Manager.

2.7 Output Window is a window that displays the results of
calculations or display Error.

2.8 Output Tool Bar is the Tool Bar which works attributed to the
Output Window.

2.9 Workspace is the area that is used to create the Single Line
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Figure A.2 The components of the Main Window

A.1.2 Modelling a system test 4 buses

Test system for model 4 bus to make it as a model system to test. IEEE

standards information to create it as a reference by IEEE Bus Feeder 4 Test Cases [12].
1)  Creating a node or a bus (Creating Terminal)

Clicking on the bus — (Terminal) or node =+ (Point

Terminal) on the Drawing Toolbar on the right side, then placed in the Workspace by
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moving areas. Mouse to where you want to create the node, or a bus, then left click 1 time
to paste. Equipment (create a vertical bus, right-click, and then select the Clockwise or
Counter Clockwise Rotate) bus as shown in Figure A.3. To cancel create the Drawing
mode, the device, press and hold the Esc or right-click 1 time, then it will be able to
choose a different image to create the device.
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Figure A.3 Create the Drawing the bus on the Workspace

Input data bus can do so by double-clicking the bus appears Dialog Box
of a loud bus as shown in Figure A.4. Each window of analysis will provide different

input. In this case study, data input as shown in Table A.1.
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Figure A.4 The input data bus or node

Table A.1 Data on that bus

Name Phase Technology Line to Line Voltage Voltage Type
BUS_A ABC-N 12.47 kV
BUS B ABC-N 12.47 kV
AC
BUS_C ABC 4.16 kV
BUS D ABC 4.16 kV

2)  To build the transmission line (Line)

Select a device line 1, (Line) from the Drawing Toolbar on
the right side, then placed in the Workspace area by clicking on one of the bus first and
then come. Click on another bus that you want to connect to the transmission line will be
the link between the two, such as a bus. Create a link between the bus line 1 and 2 by
selecting the line from the Drawing Toolbar and then click on the bus 1 first and then

click on the bus 2 as shown in Figure A.5.
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Figure A.5 Create the building transmission line

Input data transmissions made by double-clicking on a line will appear
on the Dialog Box on the line as shown in Figure A.6. Then the input data of the

transmission line as shown in Table A.2.
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Figure A.6 The input data of transmission line
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Table A.2 Data on the transmission line

Terminal Connect to BUS
Name Type of Line Length (km)
l j
Line A-B A B Line A-B Type 0.6096
Line C-D C D Line C-D Type 0.762

Then determine the type of transmission line for the case study, this will

create a kind of new Type Tower cables by selecting New Project Type => Tower Type

as shown in Figure A.7.
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Figure A.7 The input data of transmission line

A Dialog Box will appear in the input data of transmission line. Tower

model Type, as shown in Figure A.8.
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Figure A.8 To create a data transmission of a Tower Type

To choose a Mode Input Electrical Parameter and then creating the
replica of the phase line by double-clicking on a space in the first column of the first row.

Type of Conductor Line Circuits as shown in Figure A.9.
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Figure A.9 Setting conductors of the phase line
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Appears next to the Data Manager for the select or create the Guide,

clickonthe MenuBar, & asshown in Figure A.10, to make the line a new phase.
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Figure A.10 Modelling conductors of the phase line.

A Dialog Box window appears, as shown in Figure A.11 for data input
as conductor. Phase wiring for in this case study, the data input as shown in Table A.3,

when input data is finished, press OK.

Conductor Type - Equipment Type Librany\Phase_12.47_kV.TypCon

? X
Name [Phase 124710
Load Flow Nominal Voltage 1247 kW Cancel

VDE/IEC Short-Circuit Nominal Current 0.53 )
Complete Short-Circuit Mumber of Subconductors |1 3:
Conductor Model

{+ Solid Conductor
" Tubular Conductor

RMS-Simulation

EMT-Simulation {Sub-¥Conductor »|
DC-Resistance (207C) D.1501448 Ohmykm
GMR (Equivalert Radiss)  [743712  mm
Outer Diameter IW mm

Description [v Skin effect

Figure A.11 To input data, a leading cable system test phase 4 buses
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Table A.3 Data transmission line conductor

Nominal Outer
Name DC Resistance GMR Diameter
Voltage | Current | (20C) (Ohm/km) (mm)
(kV) (kA) (mm)
Phase 12.47 kV 12.47 0.53 0.190139585 7.43712 | 18.3134
Neutral_12.47 kV 12.47 0.34 0.36786180326 | 2.481072 | 14.3002
Phase 4.16 kV 4.16 0.53 0.190139585 743712 | 18.3134

Then came a Load Flow Resistance and Reactance values for input of

the transmission line and then input the values as shown in Table A.4, as shown in Figure

Al2.

VDE/IEC Short-Circuit
Complete Short-Circuit
ANSI Short-Circuit

EMT-Simulation

Hamonics/Power Quality

Tower Type - Equipment Type Librany\Line_A-B Type.TypTow

Basic Data impedancss | Admitances |
Load Flow

>
2

? X
o< ]
ﬂ Cancel
==

OK

Calculate

Figure A.12 Input Resistance and Reactance values of line test system 4 bus

Table A.4 The Resistance and Reactance data of transmission line

Name Matrix of Resistances R_ij (Ohm/km) | Matrix of Reactance X_ij (Ohm/km)
of Lines 1 2 3 1 2 3

1 | 0.284482 0.0966703 | 0.09512069 | 0.6705416 | 0.3121856 | 0.2397339

;l_ng 2 | 0.0966703 | 0.2901722 | 0.0979555 | 0.3121856 | 0.6519041 | 0.2637839

3 | 0.09512069 | 0.0979555 | 0.286934 | 0.2397339 | 0.2637839 | 0.6624669
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Table A.4 The Resistance and Reactance data of transmission line (Continued)

Name Matrix of Resistances R_ij (Ohm/km) | Matrix of Reactance X_ij (Ohm/km)
of Lines 1 2 3 1 2 3

1 | 0.2485279 | 0.0579578 | 0.05795723 | 0.8794718 | 0.5304363 | 0.452805

I(‘:"g 2 | 0.0579578 | 0.2485279 | 0.05795761 | 0.5304363 | 0.8794718 | 0.4861183

3 | 0.05795723 | 0.05795761 | 0.2485279 | 0.452805 | 0.4861183 | 0.8794718

Then, back to the Basic window, select the Data Input Mode is a

Geometrical Parameter, then it will make the modelling of conductor neutral by double

Click on the gap in the first row of the first column of Type Earth Conductor as shown in

Tower Type - Equipment Type Library\Line_A-B Type.TypTow * ? X
T
Load Flow Name [Line_A-B Type Cancel
VDE/IEC Short-Circuit Mominal Frequency 50. Hz
. - Calculate
Complete Short-Circuit Mumber of Earth Wires L 3'
ANSI Short-Circuit Mumber of Line Circuits 1 E: Transposttion |none -
Input Mode ﬂ
' Geometrical Farameter Earth Conductivy ~ [100 uS/cm
" Bectrcal Parameter
EMT-Simulation Types of Earth Conductors:
Hamanics/Power Quality Conductor Types
TypCon
I Earth Conductor 1 -
Reliability
=
4 | »
Description
Conductor Types of Line Circuits:
Conductor Types Num. of Phases | Transposition
TypCon
P Circut 1 3|E J
>
4 3

Figure A.13 Modelling line conductor of the Neutral

Data appears next to the Data Manager for the select or create the

leading neutral, click. & On the Menu Bar to create a new line neutral, guide will

appear. Window, Dialog Box, for data input line neutral, for in this case study, the data

input as shown in Table A5, as shown in Figure A.14 when the input data is finished,

press OK.
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Conductor Type - Equipment Type Library\Meutral_12.47 k¥.TypCon

? x
Nane e 2k
Load Flow MNominal Voltage 12.27 kW Cancel

WDE/IEC Short-Circuit Nominal Current 0.34 kA
Complete Short-Circuit Mumber of Subconducters | 3:
Conductor Model

{+ Solid Conductor
" Tubular Conducter

RMS-Simulation

EMT-Simulation S ot >
DC-Resistance (207C) 0.3678618 Ohmylem
GMR (Equivalent Radius) ’W mm
Outer Diameter ’W mm

Description ¥ Skin effect

Figure A.14 Data input of line neutral for test system 4 bus

Then, click on the symbol to define the values of the transmission line
Pole Configuration, as shown in Figure A.15 and then input the values in Pole
Configuration case study, this input value is Pole Configuration as shown in Table A.5,

as shown in Figure A.16.

Tower Type - Equipment Type Librany\Line A-B TypeTypTow *

? X
Load Flow Name |Line_AB Type

Cancel
WDE/IEC Short-Circuit Mominal Frequency 50, Hz
. - Calculate
Complete Short-Circuit Mumber of Earth Wires 1 5
ANSI Short-Circuit Mumber of Line Circuits 1 = Transpostion |none -
Input Mode: ﬂ
(+ Geometrical Parameter Earth Conductivity | 100 uS/em
" Blectical Parameter
EMT-Simulation Types of Earth Conductors:
Harmonics/Power Quality Conductor Types
TypCon
P Earth Conductor 1 |IETEINFRYLY
Reliability
“ | »
Description
Conductor Types of Line Circuits:
Conductor Types Num. of Phases | Transposition
TypCon

P Circuit 1 e -

Figure A.15 The input of Pole Configuration value
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Table A.5 The data pole configuration

Coordinate of Earth Coordinate of Line Circuits [m]
Conductor [m]
Name X Y X Y
1 2 1 2 3 1 2 3
'I&mg 0.1524 7.3152 | 1.0668 | 0.3048 | 1.0668 | 8.5344 | 8.5344 | 8.5344
Line
c-D - - 1.0668 | 0.3048 | 1.0668 | 8.5344 | 8.5344 | 8.5344

Tower Type - Equipment Type Library\Line_A-B TypeTypTow * ? >

Load Flow Coordinate of Earth Conductors [m]:

¥ Cancel
VDE/IEC Shor G W Earth Conducior 1 73152 - e
Complete Short-Circuit
ANSI Short-Circuit

| | 3
Coordinate of Line Circuits [m]:

EMT-Simulation X3 M 2 AEl

1.0688| B85344| B85344| B5344 -
Harmonics. /Power Qualty
Relizbility
Description

Figure A.16 The input Pole Configuration for test system 4 bus

When the value data input Pole Configuration, click on the symbol

shown in Figure A.17 will be returned to the window for input data Basic Data again, as

shown in Figure A.18, do as shown in Table A.6 data inputs.
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Load Flow

WDE/IEC Short-Circuit
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ANSI Short-Circuit

EMT-Simulation

Hameonics/Power Quality

Reliability

Description

Tower Type - Equipment Type Librany\Line_A-B Type. TypTow *

Coordinate of Earth Conductors [m]:
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fel.

Figure A.17 The window Basic Data to input data, the type of transmission line

Tower Type - Equipment Type Libran/\Line_A-B Type. TypTow

oo [

Load Flow
WDE/IEC Short-Circuit
Complete Short-Circuit

ANSI Short-Circuit

EMT-Simulation
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Reliability

Description
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—Input Mode il
% Geometrical Parameter Earth Conductivity I‘IDD_ uS/em
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< | »
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< |

OK
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Figure A.18 Window of Basic Data to input data, the type of transmission line
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Table A.6 Type of data transmission

Number Conductor Types Nominal
Name Earth Line Phases Neutral | NUM. of Frequency
Wires Circuits Phases (Hz)
Line A-B Phase Neutral
1 1 3 60

Type 1247kV | 1247 kv
Line C-D Phase

Type 0 1 4.16 kV ) 3 60

When building a transmission line A-B successfully, creating a cable

line C-D, using the same methods to create the cable line A-B.
3)  To create the transformers

To create a transformer made by selected symbols ¢  transformers.
On the Drawing Toolbar Placed in the Workspace area, click Mouse at any bus. One of
the first, and then come and click on the bus to make a connection to the transformer
model. As shown in Figure A.19 then the input data transformer by Double click that
Dialog Box will contain a transformer of transformer appears. Then create the type of
transformer. By selecting the check box, Type-a New Project => Type, as shown in Figure

A.20.
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Figure A.19 To create the transformers
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2-Winding Transformer - Grid\2-Winding Transformer.ElmTr2 4 X

_ General | Grounding/Neutral Canductor | oK
Load Flow Hame [2-Winding Transformer Cancel

VDE/IEC Short-Circuit Type [®]=|

Fi >3
Complete: Short-Circut H-Side Select Global Type ... BEE gure
ANSI Short Cireu LV-Side SRR e BUS.C Jumpto
EC 51363 Zone New Project Type ...
frea Paste Type
RMS-Simulation [~ Out of Serv

Remove Type

EMT-Simulation Number of Fiip Connections

Hamonics/Power Qualty parallel Transformers 1

Protection Themal Rating hd ad I

Optimal Power Flow Rating Factor 1 Rated Power (act.) 0. MVA
State Estimation I™ Auto Transformer

Reliability Supplied Elements

Generation Adequacy |

Tie Open Poirt Opt.

Description

Figure A.20 To input the data of transformer

Dialog Box will appear for the data input of the transformer. For the
transformers in case studies, this Technology is a Three Phase Transformer which means.
A three-phase transformer and then click on the Positive Sequence Impedance check box
is selected in Resistance and Reactance p.u. in p.u. as shown in Figure A.21, then press
OK, and configure other parameters the Table A.7 will get parameter values, as shown in

Figure A.22 and when the configuration parameters until you hit OK.

Name |2—Winding Transformer Type 0K

Load Flow Technology [Three Phase Transformer | Cancel
VDE/IEC Short-Circuit Rated Power 1 MVA
Complete Short-Circuit Nominal Frequency 50. Hz
ANSI ShortCircuit Rated Voltage Vector Group
|EC 81283 HV-Side 3 kv HV-Side -

LV-Side 3 KV Lv-Side ™

[ Intemal Delta Winding

RMS-Simulation

Fostive Sequence Impedance F

o || | Phase Shift fi] “30deg

EMT-Simulation | Reactance x1 0.03 pu. Ll
Hamonics/Power Quall Settings 2-Winding Transformer - ...\Input Options\Settings 2-Winding Transformer.OptTyp...  ? X
Frotection

(" ShortCircuit Voltags uk and Copper Losses

Zero Sequ. Representation Cancel
Relibilty ¢ Short Circuit Voltage uk and SHC-Voltage Re (k) nee
" Short-Circuit Voktage uk and X/R Ratio

L | (¥ Reactance in p.u. and Resistance in p.u

Description

Figure A.21 Select Reactance in p u and Resistance in p u
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Table A.7 Data of transformers

Positive Sequence
Rated Voltage (kV) Impe dancg (o) Vector Group
Rated P P Nominal
Power : : : Frequenc
(MVA) High Low | Resistance | Reactance | High Low (qH 7) Y
Voltage | Voltage Voltage | Voltage
Side Side rl x1 Side Side
6 12.47 416 0.01 0.06 YN D 60
2-Winding Transformer Type - Equipment Type Libran®12.47/4,16 kV. TypTr2 ? >
e frzere iRy
Load Flow Technology |Three Phase Transformer j Cancel
VDE/IEC Short Circuit Rated Power [ mva Q
Complete Short-Circuit Nominal Frequency 50 Hz
ANSI Short-Circuit Rated Voltage Vector Group
IEC 61363 HV-Side 1247 KV HV-Side N -
LV-Side: 4.16 kV LV-Side D -
RMS-Simulation Positive Sequence Impedance i} ,7 .
EMT-Simulation Reactance x1 ’[)[)57 pu. ﬂ Phase Shi o R
Hamanics,/Power Quality Resistance r1 'D[ﬂi pu. Name YhdD
Protection - -
ro Sequence Impedance
Short-Circuit Voltage uk0 3. % ﬂ
Reiabity SHC Vohtage (Refuk0) uk0r [0. %
Description

Figure A.22 Input data of the transformer

4)

To create supply

To create supply (External Grid) gg by clicking to select the

device on the Drawing window supply Toolbar, then select the desired bus connection.

Such a device would be a model as shown in Figure A.23 supply in this case studies. To

make a connection to the supply into the bus at 1, and then double-click the device supply.

The Dialog Box has been created will appear as shown in Figure A.24. Then go to the

window, Load Flow. As shown in Figure A.25, and define the Type as SL Bus, which

refers to the. Slack Bus Voltage in this case study will define the Set point is equal to 1

when the input parameter values window p.u. Load Flow and the VDE/IEC.Short-Circuit

as shown in Figure A.26 and then configure a Power Short-Circuit Short-Circuit Power

Sk max and "Ik" min. in the study assigned Short-Circuit Current max Ik ", which equal
to 100 MV A and Short-Circuit Power Sk" min. Equal to 100 MVA, then press OK.
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Figure A.23 To create supply

External Grid - Grid\External Grid ElmXnet ? X

_ General ]Ground\ng/‘Nautml Caonductor
Load Flaw Name
Cancel

VDE/IEC Short-Circuit Teminal W | = | Gid\BUS_A"Cub_2 BUS_A

Figure =>
Complete Short-Ciraut Zone | _Fase> |
ANSI Short Circuit Arez ﬂ . ... (Parameter Name: cpZone) Jump to

IEC 61363 [ Out of Service

RMS-Simulation
EMT-Simulation
Hamonics/Power Quality
Optimal Power Flow

Reliability

Description

Figure A.24 Input Data Basic of Supply
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External Grid - Grid\External Grid.ElmXnet * ? hs

Basic Data Bus Type I hd -OK
Lozd Flaw Setpoint [iocal - _ Corcal |

WDE/IEC Short-Circuit r~Operation Point

— =
Complete Short-Circuit Angle 0. deg
ANS| Short-Circuit Voltage Setpoint IT. pu. Jumpto .. |
IEC 61363 Reference Busbar hdEd!
RMS-Simulation
EMT-Simulation

Harmonics//Power Quality

i~ Reactive Power Operational Limits

1| Optimal Power Flow Capabiity Cuve W= .
Reliability Min. [[9953 Mvar  Scaling Factor (uin)  [100 %
Mazx. |9999 Mvar  Scaling Factor (max.) ITD’D. %
Description
External Grid - Grid\External Grid.ElmXnet ? X
Basic Dats ~Max_ Values ]| [ Vin Velves . i
Load Flow Short-Circuit Power Skmax MVA Short Gircut Power Skmin - [60 MVA o
no :
ShertCireuit Currert Ima [4.623914 KA ShortCircuit Current Imin [2.314957 kA |
Complete Short-Circuit R/X Ratio (max) [osss1s R/% Ratio {min.) Jed M
ANS! Short-Circut Il (rEiErER RET Jumpto ..
Z2/Z1 max. ID.&SGGEA Z2/Z1 min IT.
IEC 61363
XO/X1 mac [os XO/X1 min [
RO/X0 max. [o.se61e RO/XQ min. Jo
RMS-Simulation
EMT-Simulation

Harmonics/Power Quality
Optimal Power Flow

Religbility

Description

Figure A.26 Input data Short-Circuit of Supply
5)  Tocreate load

Creating the load (Load General) < start to build by selecting the
model of your load on the Drawing Toolbar, and then select the bus that you want to
connect to a replica. In this case study will make a connection where data input 4 bus
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makes your load by. Double-click the load will be a replica of the load, as shown in Figure
A.27 will appear. Dialog Box of the load, then creates the type of load. By selecting the
Project Type New-Type => General Load Type, as shown in Figure A.28. A Dialog Box
will appear, determine the type of Technology, as shown in Figure A.29, 3PH-D then
press OK.
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Figure A.27 Modeling of the load

General Load - Grid\General Load.ElmLod

Name  [Gonera Lood ox

? x
oz Flow e [E~| Cancel
Teminal Select Global Type ... BUS D
Figure =>
Complete Short-Circuit Zone Select Project Type ... >
Area Mew Project Type ... > General Load Type (TypLod) ump to ...
™ Out of ! Paste Type Complex Load (TypLodind)
Technolog: Remove Type [
RMS-Simulation I~ Consider Load Transfommer
EMT-Simulation

Hamonics/Power Qualty
Optimal Power Flow
State Estimation
Reliability

Generation Adequacy

Description

Figure A.28 Input data of the load
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General Load Type - Equipment Type Librany\General Load Type(1).TypLod *

EE - =
Load Flow
System Type AC -
Complete Short-Circuit Technology IPH-D" -

RMS-Simulation
EMT-Simulation

Hamonics./Power Quality

Description

Cancel

Figure A.29 Select the type of load

Then go to the window, Load Flow, make the data input as shown in

Table A.8. Because the system test 4 test system is used for transformer tests. So, a very

large load size, therefore, to test the transformer in case of overload. When analyzing

health system. Parties may need to reduce the size of the load. In this case it drops just 50

percent of the reloading of all defined spaces direct Scaling Factor equal to 0.5 shown at

in Figure A.30.
Table A.8 Data of load
Phase A Phase B Phase C
Inputl Balanced/Un Active | Reactive | Active | Reactive | Active | Reactive
Mode balanced Power Power Power Power Power Power
(MW) | (Mvar) | (MW) | (Mvar) | (MW) | (Mvar)

Default Balanced 1.8 0.8717 1.8 0.8717 1.8 0.8717
Default | Unbalanced | 1.275 | 0.79017 1.8 0.87178 | 2.375 | 0.78052
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General Load - Grid\General Load.ElmLod

| Basic Data General IM\"EIHCEd I oK
Load Flow Input Mode - J —
Balanced/Unbalanced Unbalanced - Figure >>

— Operating Poirt Actual Values

fiotive Power [6a5 hw 2,725 M/ ponniops
Feactive Power IW b sear 1221235 Mwar
Voltage |1— pu.

RMS-Simulation Sealing Factor s 05

Complete Short-Circuit

el

EMT-Simulation [+ Adjusted by Load Scaling Zone Scaling Factor: 1.
Harmonics/Power Quality " Phase 1 Actual Values
Optimal Power Flow Active Power [iz7s aw 0.6375 MW
State Estimation Reactive Power 0.73017 Mvar 0.395085 Mvar
Reliability
—Phase 2 Actual Valu,
Generation Adequacy
— Active Power |1.8 M 0.9 MW
Description
Reactive Power ID.S?WS Mvar 0.43589 Mvar
—Phase 3 Actual Value
Active Power |2.3?5 MW 1.1875 MW
Reactive Power 0.78052 Mvar 0.35026 Mvar

Figure A.30 Input the size of the load

When finished, the system will be tested the system 4 bus, as shown in
Figure A.31.
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Figure A.31 Circuit tested the system 4 bus
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A.2  Tocreate the replica of the relay
A.2.1 Selecting the use relay.

Selecting the use, a relay which has

Select the type of relay
- Inverse

- Moderately Inverse

- Very Inverse

- Extremely Inverse
- Instantaneous — = ="

a step is used, as shown in Figure A.32.

Select Current Transformer

|

Set the start higher than the load

currents up to 2x.

1 Calculate the maximum load current.

A

Calculate the minimum short-circuit |
currents.

Set to start the relay at the minimum
short-circuit currents.

!

Set to start the relay at the maximum
short-circuit currents.

| Calculate the maximum short circuit
current.

Figure A.32 Selecting the use relay

1)  To select the type of relay
s Inverse

s Moderately Inverse

s Very Inverse

< Extremely Inverse

o Instantaneous
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2)  The maximum load flow analysis, then adjusts the flow starts, set higher

than the maximum load current 2 x.

3)  Analysis, find the minimum short-circuit current by making an analysis,
three-phase short circuit current at the position the installation end of relay, and then

adjusts the flow setting, work during the minimum short circuit current.

4)  Analysis, find the maximum short-circuit current by making an
analysis, three-phase short circuit current at the position the load end of the cable, and

then adjusts the flow setting, work during the maximum short circuit current.

A.2.2To create the replica of the relay

To create the replica, the relay will be built on the grounds of origin,
transmission line, right-click the area of the source line and then choose New Devices=>
Relay Model. As in the picture Dialog Box in Figure A.33 window appears, as shown in
Figure A.34.
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B File Edit View Insert Data Calculation Output Teels Window Help - X
8w &R P: LB TE 7] EAN M= XS >
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Figure A.33 To create the replica of the relay.
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Relay Model - Grid\BUS_A\Cub_1\Relay Model.ElmRelay

Caegery o

Tl

CurmentVoltage Transformer Name Relay Model Cancel
Mazc./Min. Fault Cuments Relay Type vl - |
— Conterts
Description Application I Main Protection vl Device Number I'I E
Location
Reference Vl hd |
Busbar | Gid\BUS_A
Remote End = GrdBUS B
Connected Branch j Grid Line_A-B Grid\BUS_B (Parameter Name: cn_rembus)|
]
I™ Ot of Service
Slat D efinition:
Met Elements
Rel”,Elm™ Sta”,Int Ref
> 1 -

2

< [» I—I
Slot Update |

Figure A.34 Dialog box for data input relays

Then select the type of relay by clicking the Select Project Type-Relay
=> Type, as shown in Figure A.35 and then press OK.
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Relay Model - Grid\BUS_A\Cub_1'Relay Model.ElmRelay

Curment.\oltage Transformer Name

Max./Min. Fault Cuments Relay Type

Description Application

Location
Reference

Busbar

Remote End

|Refay Mode!

[~ Out of Service

Select Global Type ...
Select Project Type ..

MNew Project Type ...
Paste Type

Remove Type

Connected Branch ﬂ Grid'Line_A-B

Cancel

Contents

MNet Elements

Rel”,Elm" Sta” IntRef

[ ot |

b

K

Figure A.35 Selecting the type of relay

Data Manager Window appears for the selected type of the relay. For a

case study, this will select the Inverse Time Overcurrent relay from the Main Library of

the Program by clicking on the Library-> Relays-Overcurrent Relays => General Electric-

IAC >=> 60Hz => Series-Long-Time Inverse => IAC66B51A => as shown in Figure

A.36.
Please Select 'Relay Type' - \Library\Relays\Relays\Overcurrent Relays\General Electrich|AC Serie\60Hz\Long Time Inverse:
By By BRGSO A
ft Generic ﬂ MName Type Object modified 8]
EI ) Relays
[l Directional Relays T |IACEBASTA Toc + loc Ph & Earth [12/6/2006 9:53:256 P A|
[l Distance Relays T |IACEBASZA Toc Ph & Eath 12/6/2006 9:53.25 P—
1 Ul Overcument Relays T |IACEEA52A Toc Ph & Earth
% éI;B;:::Inghouse m ] [Toc + loc Ph & Earth
= ff] General Blectric T3 |[IACEBB52A Toc + loc Ph & Earth [12/6/2006 5:53:25 P
B U 1AC Serie B3 [IACEEES3A Toc = loc Ph & Eath | 12/6/2006 953.25
tht 50Hz B3 [IACBRE54A Toc = loc Ph & Earth | 12/6/2006 9:53.25
=1 H 60Hz T |IACEBES5A Toc + loc Ph & Earth | 12/6/2006 9:53.25 P
ft Extremely Inverse T3 |IACRREESEA Toc + loc Ph & Earth [12/6/2006 9:53:25 P
O Inverse T |IACEBBSTA Toc + loc Ph & Earth | 12/6/2006 9:53.25 P
U Long Time Inverse B |IACEBCH1A Toc = loc Ph & Earth | 12/6/2006 953:25 P
(K Short Time Inverse T3 _|iACesc52A Toc + loc Fh & Earth | 12/6/2006 9:53:25 F
mn] Vew |n\u’BI’SE = W ol ao'nd e 0 1 T, 1 Ol 9 Tl 14 JuleaTa¥ a¥ull oW =t Pea] =4 nj
[ Characteristics |
Ln4 31 object(s) of 31 1 object(s) selected

[4 X

T
Cancel
Global Types
Project Types

Figure A.36 Selecting the type of relay from the Library
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Then it will be created by clicking the Create CT current transformer,

as shown in Figure A.37.

Relay Model - Grid\BUS_A\Cub_1"Relay Model.ElmRelay *

i

Curment.Voltage Transformer Name |Re|a=,' Model Cancel
Maze./Min. Fault Cuments Relay Type w|=| . z\long Time Inverse'\|ACEEBS1A
— Contents

Description Application Main Protection - Device Number |1 3'

Location

Reference b adl PO

Busbar ﬂ Gid\BUS_A

Remote: End | Grid\BUS_B

Connected Branch ﬂ Grid'Line_A-B

[~ Out of Service
Slot Definition:
MNet Elements
Rel®,Elm*,Sta® IntRef
C2-3P/ 10 -
Meas 3ph/310 |Meas 3ph/310
Toc ¥ Toc —
loc ¥ loc
Toc Earth ¥ Toc Earth
loc Earth ¥ loc Earth
Logic Ph ¥ Logic Ph
Logic Earth ¥ Logic Earth
1 [ » ]J

Slot Update | Create CT |

Figure A.37 To select of current transformer

Dialog box window appears for the input data, current transformer, then
select it by clicking on the current transformer. Type-Select Project Type => as shown in
Figure A.38.
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Current Transformer - Grid\BUS_A\Cub_1\Current Transformer.5taCt 7 >
MName |Currer|t Transformer OK
Additional Data Type e Cancel
Description ™ Out of Serv Select Global Type ...
Cubidle Select Project Type ...
Location Mew Project Type ...
B Paste Type
Branch
Remove Type
Oriertation IRt —
Primary Secondary
1. 1.
Set Connection Y -
Ratio: TAMA Complete Ratio: 1AMA
MNo. Phases 3 - Phase Rotation abc hd

Figure A.38 To create a current transformer

Data Manager for window appears, select the type of current
transformer for this case study will select type current transformer CT 120-1000/1A from
the Main Library of the. Program by clicking on the Library => Relays => CTs-120 CT-
1000/1A => shown in Figure A.39.

Please Select 'Current Transformer Type' - \Libran/\Relays\CTs : ? *
% @ £ G b 4 EE
= Library ﬂ Name Type Object modified o}

[l Characteristics T
[t Composite Model Frames = i C 1246/ 16 F'n
{0 Conductors CT 120-1000/5A 12/6/2006 35316 P
fititll General Composite Folder a Sl
ftitl Hamonics .
HH 1EC Standard Cable oSO IpeS
fll Induction Machines
[t Induction Machines {old version)
fhl Motor Driven Machines
(il PV Panels
=t Relays

(it Fuses

fitl Generic

[t Relays j
0 VTs i

Ln1 2 object(s) of 2 1 object(s) selected

Figure A.39 To select the type of current transformer from the Library

Then set the tap flows of current transformer for a case study, this will
set up the primary-side current tap kept at 1000 A. Secondary and therefore 1A as shown
in Figure A.40.
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Secondary

Tap 1. -| A
Connection Y -

Complete Ratio: 1000414
Fhase Rotation ab< -

Current Transformer - Grid\BUS_A\Cub_T14Current Transformer.5taCt *
Name |Currerrt Transformer
Additional Data Type w | = | “Librany\Relays\CT=VCT 120-1000/14
Description [ Out of Service
Cubicle |
Location
Busbar | Gidveus_a
Branch | Grid\Line_A-B
Orientation > Branch |
Primary
Tap 1000, ~| A
Set
Ratio:
No. Phases

7 >
Cancel

Figure A.40 To settings tap current of current transformer

After creating the replica, the relay and current transformer, it will set

the stream starts. And the value of the multiplier value is set at the time of the relay for

convenience. User can settings the time current curve (TCC) graph Curve with a set by

the source, right-click the area of the line creating the replica relay. Then choose Create

Time-Overcurrent Plot (TOP) as shown in Figure A.41. TOP window appears as shown

in Figure A.42.
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Figure A.41 Shows TCC graphs

M DIgSILENT PowerFactory 15.1 - [Graphic : Study Cases\Study Case\Graphics Board\Time-Overcurrent Plot]
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Figure A.42 Shows the TCC

Then double-click the graph area that resembles a curve Dialog box

window appears. For a start, and the currents set up the multiplier relay timing type

Inverse Overcurrent Relays. Dialog box without Shows that curves that make double-
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clicking away it is a relay which type curves (number 51 is the Inverse Overcurrent

Relays). And are used to protect phase or ground, as shown in Figure A.43.

4
m' File Edit View Insert Data Calculation Output Tools Window Help
4w = . = e |
Bl adaB P e D& 5l 2 e EE s TR e
PP MG SE| Ma sk « LE = Lol 28 o =
w0
0y Tirme Overcurrent - Grid\BUS_A\Cub_1\Relay Model\Toc.RelToc 7 *
T T Measure Type: Phase Cumrent {1ph}
ripping Times
Cancel
(N Blocking ETE ,E
o i Relay
\H\D\D\ Description Type J ig"\60Hz\Long Time Inverse"\|ACEEB51A\Toc
[~ Out of Service Calculate
Tripping Direction None -
Charactsristic [1AC Long Time Inverse GESTOM4E. |
Curent Setting 06 - |secA D6pu. 600. pri.A
Time Dial 5. hd

| s

[ =[F[4 T4 P M Grd", Time Overcurrent Plot

Figure A.43 Dialog box set a multiplier to adjust Inverse Overcurrent Relays type

If you double-click the graph area that resembles a straight-line Dialog
box window appears. For setting the stream start relay-type Instantaneous Overcurrent.
Dialog box without Relays will indicate whether the curves that make double-clicking
away it is a relay which type curves (number 50 is the Instantaneous Overcurrent. Relays)

and anti-phase or ground, as shown in Figure A.44.
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W' File Edit View Inset Data Calculation Output Tools Window Help
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a Instantaneous Overcurrent - Grid\BUS_A\Cub_T\Relay Model\loc.Relloc

IEC Symbol I35 ANS| Symbol: 50

IL

=

fell )

i Topping Trmes Measure Type:  Phase Cument (1ph) e
Blocking ETE
Descrtion Type | ..i€\60Hz\Long Time Inverse\ACEBB51A\oc Reiay
I~ Out of Service
Tripping Direction ’m
Pickup Curent ’E— sec.A B.pu. 6000. pri. A
Total Time D04s

Ln1 |2 object(s) of 2 [1 object(s) selected

=] == Tonat

T
o

[ =[=[4]4] ¥ [M[\ Grd  Time-Overcurrent Plot

Figure A.44 Dialog box for setting Instantaneous Overcurrent Relays type

In case of need to use the Inverse Type Overcurrent relays only one
type, make a click in the Relay as shown in the picture Dialog box window appears of

relay as shown in Figure A.45.

Time Overcurrent - Grid\BUS_A\Cub_1\Relay Model\Toc.RelToc ? *
IEC Symbol: [t ANSI Symbol: 51
Tipping Times Measure Type: Phase Cumrenrt (1ph) e
Blocking e ,E
Descrption Type ﬂ ... i%60Hz\Long Time Inverse“ACEEE51A\Toc Relay
[ Out of Service Calculate
Tripping Direction m
Characteristic |IAC Long Time Inverse GES70048 |

Current Setting D& v | sec A D6pu. 600. pri.A
Time Dial 5. A

Figure A.45 To access the Dialog box window of the relay
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Then double-click on the loc in the Slot Definition, as shown in Figure

A.46 Dialog box window appears of Instantaneous Overcurrent Relays.

Relay Model - Grid\BUS_A\Cub_1\Relay Model.ElmRelay

i

CumentVoltage Transformer Name |Fh3|a1.r Madel Cancel
Mae./Min. Fault Cumrents Relay Type w|=| . z\Long Time Inverse\ACGEBS1A
= Contents

Description Application | Main Protection ﬂ Device Number |1 E

Location

Reference b lndl S8

Bushar = Grid\BUS_A

Remote End = Grid\BUS _B

Connected Branch = | Grid“Line_A-B

[ Out of Service

Slat Definition:

MNet Elements
Rel* Blm*,5ta” Int Ref

Ci-3P/ 20 ¥ Cument Transformer -
Meas 3ph/210 |Meas 3ph/3I0
Toc ¥ Toc -
Toc Eath | ¥ Toc Earth
loc Earth ¥ loc Earth
Logic Ph ¥ Logic Ph
Logic Earth ¥ Logic Earth

-
1 | »

Slot Update |

Figure A.46 Dialog box window of the Instantaneous Overcurrent Relays type

Make click on Out of Service as shown in Figure A.47 then click then
OK change the double-clicking working Definition Earth in loc Slot, click the Out of
Service. Similarly, and for the consideration in this case is only a short-circuit style phase
(Phase Fault). So, do double-click in Toc Earth Slot Definition. Make click on Out of

Service as well.
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Cument/Voltage Transformer  Name |Relay Modsl Cancel
Mz Min. Fault Curerts Relay Type w | = | z\long Time Inverse\|JACEEBE1A
- Contents
Description Application |Main Protection j Device Number | 31
[ Lecation |
Instantaneous Overcurrent - Grid\BUS_A\Cub_1'\Relay Modelloc.Relloc ™ ? >
o Measure Type:  Phase Cument (1ph)
Tripping Times Cancel
Blacking ETE ||DC
Description Type J ie"60Hz Long Time Inverse“\ACEEB51ANoc
¥ Out of Service
Tripping Direction MNone -
Pickup Current 6. sec. A B pu. 6000, pri.A
Tatal Time 0.04 s
lelci—— - |
Toc Earth ¥ Toc Eath
loc Earth ¥ loc Earth
Logic Ph ¥ Logic Ph
Logic Earth ¥ Logic Earth
7 A | » /_‘
Siot Update |

Figure A.47 Working out of Service with Instantaneous Overcurrent Relays type

Then adjusts the flow setting start relay, start relay without work is
higher than the maximum load current coordinates. And relays must be active during the
short circuit current and maximum flow. The minimum short circuit in the area of the
scope of health. Parties of the relay, which maximum load current can be obtained from
the analysis of power flow. By clicking on the symbols on the Main Tool Bar will appear
the window Load Flow Calculation, <& as shown in Figure A.48, select the set-up
parameters that are used in the calculation. If the system is used as a load balancing load
(Load Balanced), select the Calculation Method as an AC Load. Flow, Balanced, positive
sequence, but if the system is used to load a load balancing (Unbalanced Load), select the
Calculation Method as the Unbalanced Load Flow, AC, 3-phase (ABC), and then click

the Execute button. To have the program calculate as configured.
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Figure A.48 In the configuration window, Load Flow Calculation in order to analyze,

find the maximum load current

Notice that the graph Curve if TCC during the relay, maximum load

current, as shown in Figure A.49, adjust settings, stream relay starts up by double-clicking

away. Graph line, then adjust the Current Setting to a higher value, as shown in Figure

A.50.
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Figure A.49 The relay operates during the peak load currents
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Figure A.50 Configuring the current setting starts

When setting is complete, try to analyze the flow of electro. Again, if

relay is not working during high load current. Curve graphs will be shown in Figure A.51.
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Figure A.51 Relay is not working in the current maximum load after setting the current

starts

For the minimum short-circuit current can be obtained from the analysis
of short circuit if the current position is a bus node connected load ends. The cable sent
by bus or position. The node is attached to the load area. It is outside the scope Pro. Parties
of the relay by right-clicking the node or the bus. Select the Calculate => Short-Circuit,

as shown in Figure A.52.
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Figure A.52 Analysis of short circuit, if the current position is a minimum bus node

connected to the load line ends

Short-Circuit Calculation window appears, set the Calculate a Min.
Short-Circuit Currents, which refers to the analysis if the minimum short-circuits current,

then click on Execute As shown in the Figure A.53.
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Figure A.53 In the configuration window to Short-Circuit Calculation. For analysis find

the maximum short circuit current

Notice that the graph Curve if TCC relay does not work in the minimum
short-circuit current, as shown in Figure A.54, adjust settings, stream relay starts up by
double. Click on the graph line, then make adjustments to higher Current Setting as shown
in Figure A.55, when tuning is complete, try to do the analysis. Find the short circuit
current again. If the relay is working on the maximum short circuit current. The graph

will be shown in Figure A.56.
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Figure A.54 Relay will not working during short circuit current low
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Figure A.55 Setting the current starts
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Figure A.56 The relay will be work during the relay of current low, after setting the

current setting starts

When setting relay in the circuit minimum, analyze, find the short
circuit current Max. Maximum flow was mostly short circuit can be obtained from the.
Short circuit current for transmission line position area to create a source replica relay to

remove them. By right-clicking the line creating the replica relay to remove them. Select
the Calculate => Short-Circuit, as shown in Figure A.57.
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Figure A.57 Analysis area, find the maximum sho

transmission line

rt-circuit current source of

Short-Circuit Calculation window appears, set the Calculate a Max.

Short-Circuit Currents, which refers to the analysis, fin

ding the maximum short-circuit

current assigned relative 0 to 100%, which means for Short circuit current at the beginning

of the line area, and then click Execute, as shown in Figure A.58.

Short-Circuit Calculation - Study Cases\Study Case\Short-Circuit Calculation.ComShe ™

Method | IEC 60309 ~|  Published
Adwvanced Options Fault Type | 3-Phase Short-Circuit |
Verfication Caleulate Max_Short-Circutt Currents -

Max. Violtage Tolerance for LV-Systems

O
T

Short-Circutt Duration
Break Time Used Break Time

Fault Clearing Time (th)

Fault Impedance
[™ Enhanced Fault Impedance Definition

Resistance. Rf 0 Ohm

Reactance, X 0. Ohm

Fault Location

At | User Selection j

User Selection w | = | Grid\Line_A-B
v Show Output
Command ﬂ Study Cases \Study Case Output of Results

Shows Fault Locations with Feeders

Short-Circuit at Branch./Line

Fault Distance from Length of line: 0.6
@ Teminali: ... etwork Data“Grd\BUS_A Absolute: 0. km
" Teminalj: ... etwork Data“Grid“BUS_B

096 km

Relative: |0. %

2001 - Execute
Close

Cancel

Contents

Fleel

global hd

165



Figure A.58 In the configuration window to Short-Circuit Calculation.For analysis find

the maximum short circuit current

Notice that the graph TCC Curve if the relay works in the maximum
circuit shown in Figure A.59 then it is not necessary to adjust the flow setting start relay.
If relay is not working at the maximum short-circuit current range, adjust the set flow

relay starts up. But it must not exceed the minimum short-circuit current range.

Ml DIgSILENT PowerFactory 15.1 - [Graphic : Study Cases\Equ-LFIEW]@Boundary(1)\Graphics Board\Time-Overcurrent Plot] -
B File Edit View Inset Data Calculstion Output Tools Window Help

Bl GaEP LS BEEE 2B 0B e B8 s a4k E "

PpOf M a8 N ek «RE o Bl LESLD SEHE [ -

100 T=4300.735 PrL.x

Relay Model

IAC Long Time Inverse GEST004B
pset: 0.60 sec.A

Tpset: 5.00

Tripping Time: 6.111 s

\ 6.111s

1
12.47kV 100 1000 [pri.A] 1000/
—— BUS_A(1)\Cub_I'Relay Model

[ FM AP M Gid ', Time O Plot 4 |
0 4 zEeE
‘ afivaie Wandows. » ||
=] T DB 1785 [1/1/1970 7:00:01 AM  (EE 4 Bus Test Feeder Cases
- s

Figure A.59 Relay will be work the during the short circuit current max

A case study for this test system bus 4, adjust the relay as shown in
Table A.9.

Table A.9 Data of setting the relay

Relay Name Relay Type Curve Name SuggentSefling Time Dial
(sec.A)
Relay Model IAC66B51A Toc 0.5 5

A.3 Modelling of contingency analysis
A.3.1 Contingency analysis

In general terms, an emergency analysis can be defined an evaluation of the

electrical systems and security levels as shown in Figure A.60.
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Figure A.60 Processing in contingency analysis

1)  Contingency definition

Contingency definition is selected by passing the condition, according
to the following as creation of contingencies and network component as shown in Figure
A.61.

4

W1 File Edit View Inset Data Calculation Output Tools Window Help

B G d B M B 3 = 6 @EE s TR RB E >
& opOh: -] Bk ki ST a8 &I =oBE 110kV _~|[ABC - 2,
. o . . S . ] S . HJ=——-Qcq
=18
= N - =F =
g £ | Contingency Definition - ..(1)\Contingency Definition.ComNm... 7 X e BX
T T | | Crestion of Contingencies e O
" Generate Fauit Casesfor Library
E (% Generate Contingency Cases for Analysis M ® @ @ ? @ &
“ Cancel BOO®ZGas
Outage Level =
W n-lcases _Corterts | v
I n2oases
LT ——— [a ] 22 +RE
=R LG
Network Componerts ST S U =
Create Cases for Whole system -
@ &
¥ Lines/cables [ Series Capactors e < =
W Transformers [V Series Reactors @ @ @ @
| Generators [
$ e = —
| == 4| 4| ¥ | MM\ Grid { Time-Overcurert Plot

Figure A.61 Contingency definition

After, click on the symbols s¢. on the Main Tool Bar will appear
the window Contingency definition, as shown in Figure A.61, select the set-up parameters
that are used in the calculation. If the system is used as N-1 Cases, select the Calculation

Method as Generate Contingency Cases for Analysis, Create Cases for whole system,
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Lines/Cables, and then click the Execute button. To have the program calculate as

configured.
2)  Contingency analysis

A contingency analysis can be defined as the evaluation of the. The
level of security of the power system .Contingency analysis generally involves Analysis
of abnormal system condition is a major problem both in planning by calculation method

and limits for recording as shown in Figure A.62.
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Figure A.62 Contingency analysis

After, click on the symbols . ¢z on the Main Tool Bar will appear
the window Contingency analysis, as shown in Figure A.62, select the set-up parameters
that are used in the calculation. If the system is used calculation method as alternating
current (AC) Load Flow, direct current (DC) Load Flow, and DC Load Flow+ AC Load
Flow for Critical Cases, select the Calculation Method as AC Load Flow, select the Show
button for add cases, and then click the Execute button. To have the program calculate

max loading of line as shown in Figure A.63.
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Figure A.63 The program calculate max loading of line
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APPENDICES B

DIgSILENT Programming Language (DPL) function

B.1 DPL Command (Script)
B.1.1 Script DPL of contingency analysis

1.  objecto_con,0_Lines,0_conN;

2. setset_Lines;

3. intiColiRow;

4.  double a,b,min,max,dValue;

5. string sSName;

6.  EchoOff ();

7. ClearQutput();

8.  xlStart();

9.  xlISetVisible(1);

10. xINewWorkbook();

11.  o_conN=GetCaseObject('ComNmink’);
12.  o_con=GetCaseObject('ComSimoutage");
13. o_con:loadmax=LoadingMax;

14. o_con:vimin=LowerVoltage;

15. o_con:vimax=UpperVoltage;

16. o_con:vmax_step=StepVoltage;
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17.

18.

19.

20.

21.

22.

23.

24.

25.

26.

27.

28.

29.

30.

¥

9

33.

34.

35.

36.

37.

0_con.Execute();

set_Lines = SEL.GetAll('EImLne’);

set_Lines.SortToVar(0,'c:maxLoading’);

iRow=5;
iCol=6;

sName="Name of Line";

xISetValue(iCol,iRow,sName);

iRow=5;

iCol=7;

sName='Overloading (N-1)(%)";

xISetValue(iCol,iRow,sName);

iRow=6;

for(o_Lines=set_Lines.First();0_Lines;o_Lines=set_Lines.Next()){

printf(‘'Contingency of %s

%%’',0_Lines:loc_name,o_Lines:c:maxLoading);

iCol=6;

sName=0_Lines:loc_name;

xISetValue(iCol,iRow,sName);

iICol=iCol+1,

dValue=0_Lines:c:maxLoading;

xISetValue(iCol,iRow,dValue);

iRow=iRow+1;
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38.

39.

40.

41.

42.

43.

44,

45,

46.

47.

48.

49.

50.

ol.

24,

oo

54,

55.

56.

S7.

58.

}
iRow=5;
iCol=8;

sName='"l (kA)";

xISetValue(iCol,iRow,sName);

iRow=6;

for(o_Lines=set_Lines.First();0_Lines;o_Lines=set_Lines.Next()){

printf('Contingency  of

%%"',0_Lines:loc_name,o_Lines:c:Imax);

dValue=o0_Lines:c:Imax;

%s

xISetValue(iCol,iRow,dValue);

IRow=iRow+1;

¥

xITerminate();
EchoOn ();
TD_zone_1.Execute();
TD_zone_2.Execute();
TD_zone_3.Execute();
TD_zone_4.Execute();
TD_zone_5.Execute();
TD_zone_6.Execute();

TD_zone_7.Execute();
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59. TD_zone_8.Execute();
60. TD_zone 9.Execute();

B.1.2 Script DPL of coordination time (3 phase and 1 phase fault)

s TD_zone 1,2,3,4,5,6,7,8,and 9.
1.  set SCom,Shus,srelay,SRelay,SRelayCont;

2.  oObject
OCom,Obus,0SC,0ORelayMain,ORelay_Br,ORelay_Bus,ORelay_BB;

3. object OToc_set,Obusa,Obusb,OLdf;
4.  double Fault,DRuT,DRuUT _old;

5. intl, IRelay, INRelay,Name,lh;

6.  string Value;

7.  ClearOutput();

9.  Sbus= SetBus_Zonel.GetAll(EImTerm’);
10. 1 = Sbus.Count();
11. if (1=0) {

12. Info('No busbars or terminals selected : nothing to do');

13.  exit();
14. }
15, nnnniMax Short circuit!tHmn

16. Obus= Shus.First();

17. OSC = GetCaseObject('ComShc);
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18.

19.

20.

21.

22.

23.

24.

25.

26.

217.

28.

29.

30.

31.

32.

33.

34.

35.

36.

37.

38.

39.

EchoOff() ;

OSC:iopt_shc = "3psc’;

OSC:iopt_mde=1;

OSC:iopt_cur=0;

OSC:iopt_allbus=0;

OSC:shcobj = Obus ;

OSC.Execute() ;

Fault = Obus:m:Ikss;

printf('Fault current at end of Protection Zone = %f kA',Fault);
SRelay=SetRelays_Zone.GetAll('EImRelay");

IRelay = SRelay.Count();

OCom=GetActiveProject();
SCom=0Com.GetContents('TD_zone");
OCom=SCom.FirstFilt('TD_zone");

for (INRelay=0;INRelay<IRelay;INRelay=INRelay+1){
OCom.GetVal(Value,'IntExpr',INRelay);
sscanf(Value,'%d',Name);

printf( '%f',Name);

¥

1=0;

for (INRelay=0;INRelay<IRelay;INRelay=INRelay+1){
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40.

41.

42.

43.

44,

45.

46.

47.

48.

49.

50.

51.

52.

53.

o4,

55.

56.

S7.

58.

59.

60.

61.

OCom.GetVal(Value,'IntName’,INRelay);
ORelayMain = SRelay.FirstFilt(\Value);

printf( '%s',0ORelayMain:loc_name);

SRelayCont = ORelayMain.GetContents();
ORelay_Br = ORelayMain:cbranch ;
ORelay_BB = ORelayMain:cn_bus ;

Ih = ORelay_Br.VarExists (‘r:busl:r:icpRelays:0:c:yout');
if(lh=1)

{

DRuT = ORelay_Br:r:busl:r:.cpRelays:0:c:yout ;
¥

if(lh = 0)

{

DRuT = ORelay_Br:r:bus2:r:cpRelays:0:c:yout ;
¥

if(Ih=1){

Obusa=ORelay_Br.GetNode(0);
Obusb=0ORelay_Br.GetNode(1);
if(ORelay_BB=0busa){

DRuT = ORelay_Br:r:busl:r:.cpRelays:0:c:yout ;

}
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62.

63.

64.

65.

66.

67.

68.

69.

70.

71.

72.

73.

74.

75.

76.

77.

78.

79.

80.

81.

82.

83.

if(ORelay_BB=0bush){

DRuT = ORelay_Br:r:bus2:r:cpRelays:0:c:yout ;
¥

¥

printf('%s','Operating Time of Relay’) ;
printf('%f s',DRuT) ;

printf('%s'," ") ;

if(1>0){

if(DRUT>DRUT _old*0.9){
while(DRUuT>DRuT _old*0.9){

if(1=2){

break;

¥

OToc_set = SRelayCont.FirstFilt('51PL") ;
OToc_set:Tpset = OToc_set:Tpset - 0.01 ;
OLdf = GetCaseObject('ComLdf");
OLdf:iopt_net = 0;

ResetCalculation();

EchoOff() ;

OLdf.Execute();

OSC.Execute() ;
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84.

85.

86.

87.

88.

89.

90.

91.

92.

93.

94.

95.

96.

97.

98.

99.

100.

101.

102.

103.

104.

105.

Ih = ORelay_Br.VarExists ('r:busl:r:cpRelays:0:c:yout’);
if(lh=1)

{

DRuT = ORelay_Br:r:busl:r:.cpRelays:0:c:yout ;
¥

if(lh = 0)

{

DRuT = ORelay_Br:r:bus2:r:cpRelays:0:c:yout ;
b

if(Ih=1){

Obusa=ORelay_Br.GetNode(0);
Obusb=0ORelay_Br.GetNode(1);
if(ORelay_BB=0busa){

DRuT = ORelay_Br:r:busl:r:cpRelays:0:c:yout ;
h

if(ORelay_BB=0busb){

DRUT = ORelay_Br:r:bus2:r.cpRelays:0:c:yout ;
¥

¥

printf('%s','New Operating Time of Relay') ;
printf('%f s',DRuT) ;

printf('%s','>>>>>>>>>") ;
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106.

107.

108.

109.

110.

111.

112.

113.

114.

115.

iIf(OToc_set:Tpset<0.1){
break;

¥

¥

¥

¥

DRuT _old = DRuT;
I=1+1;

}

ResetCalculation();
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